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Introduction
Congratulations with purchasing FAXmaker. FAXmaker for Exchange will save your company time and 
money by offering you advanced network fax technology. With FAXmaker, sending a fax is as easy as 
printing a document. 

FAXmaker for Exchange is designed to integrate seamlessly with MS Exchange server. Therefore this 
manual assumes a working knowledge of Microsoft Exchange server, and that you have Exchange server
up and running.



Requirements
FAXmaker for Exchange requires the following;

· MS Exchange Server

· A Windows NT server machine with at least 32 MB memory and a 100 Mhz Pentium. The machine 
does not need to be dedicated to FAXmaker. You can run the FAXmaker server alongside the MS 
Exchange server Windows NT machine. FAXmaker requires very little resources or processing time.

· One or more class 2 compatible fax modems, preferably quality modems. FAXmaker uses standard 
CLASS 2 fax modems. Although technically speaking you can use any class 2 modem, the reliability 
(how long you can leave the modem unattended), connect rate (average bps speed at which your 
faxes will be sent) and connect success percentage (The amount of fax machines the fax modem will 
not connect to) will depend almost entirely on the quality of modem you use. We recommend using a 
quality fax modem such as Zyxel or Multitech. They may cost a little more, but they are well worth the 
extra money.

I Why class 2 and not class 1? Class 2 is actually a more advanced protocol, which offloads a lot of the 
processing time to the modem. This allows your fax server to use less processor time and to be less 
sensitive to machine load.

I Although FAXmaker includes a driver for US Robotics, GFI FAX & VOICE do not recommend the use of 
US Robotics modems. The fax part of the modem is not as good in terms of connect rate, connect 
success rate and reliability as other modems. 



The FAXmaker system
The FAXmaker system consists of a Fax server program running as a gateway or "Connector" on the 
computer running Exchange server, and the client software, running on the users' workstations. The client
software consists only of a fax printer driver and a viewer, which enables all Exchange users to send a fax
by printing to the FAXmaker driver.

The system is depicted in the following figure;

Figure 1 FAXmaker fax gateway running on MS Exchange server.

Figure 1 shows the FAXmaker fax server/gateway running on the Exchange server machine. Because 
FAXmaker was designed to run on Windows NT, it does not require a separate machine. Rather it will run 
in the back ground on the same machine as MS Exchange server.



Preparing for the installation of FAXmaker for Exchange
Before continuing installation of FAXmaker for Exchange, ensure that you have understood how it works 
and that the requirements mentioned at the beginning of this chapter are met. Furthermore, you will need 
to have Exchange server up and running. Please consult the manual of Exchange to find out how to do 
this.



Introduction
This chapter describes the installation of the FAXmaker software onto the Exchange server. It will help 
you choose the installation options available, but will not discuss the user's configuration options, which 
are explained in the following chapter.

Prior to running the installation procedure, you are advised to read the chapter "FAXmaker - an overview".



Running the installation procedure
BEFORE STARTING THE FAXMAKER FOR EXCHANGE SETUP PLEASE MAKE SURE THAT THE 
EXCHANGE ADMINISTRATOR IS NOT RUNNING.

IF YOU ARE REINSTALLING FAXMAKER, BE SURE TO DELETE THE DIRECTORY OBJECT IN THE 
EXCHANGE ADMIN FIRST.

1. Insert disk 1 of the FAXmaker for Exchange disk set in your diskette drive. Remember that you must 
run the installation program from the computer running Exchange server.

2. Run 'setup.exe' from the File Manager or choose 'Run' from the 'File' menu in Program Manager and 
type in <a:\setup.exe>.

3. The set-up procedure will now start, and you will be prompted by the installation routine whether you 
want to continue set-up. Click on the 'Continue' button.

4. Setup will prompt you which language you wish to install. This option refers to the language in which 
FAXmaker will appear. 

5. Setup will now prompt you for your company name, fax number and registration number. The 
registration number is located on the disk envelope. If you are evaluating the product, do not enter a 
registration number.

6. FAXmaker will prompt you for the country in which you are located. Please enter the appropriate 
country.

7. The setup will now query the name of the server computer. Please confirm it.

8. The setup program will now query the organisation/site, which    consists of the site/organisation name 
and domain name. In most situations, FAXmaker will return the correct site name and domain name, but 
sometimes the automatic querying will not succeed or return erronous information. 

Therefore you must always check it as follows;

The format of the organisation name should be as follows;

/o=SITE NAME/ou=DOMAIN

Where Sitename is the name, shown at the top of the Exchange administrator. For example, in the screen
grab below, this is GFI FAX & VOICE. If you site name contains spaces or other special characters, you 
must    enclose the site name in qoutes, as follows; "GFI FAX & VOICE".

The domain name is displayed in the Exchange administrator with a "World" icon next to it.

9. Setup will now prompt you for an administrator account to run the service. You should enter the name 
and password of a valid NT account with administrator rights.

If you change your password after installing FAXmaker, you must update the password for the FAXmaker 
gateway and fax services from the control panel as well. Otherwise the services will no longer start.

10. Setup will prompt you whether your domain has multiple Exchange servers or not.    If you do have 
multiple EXCHANGE servers, select multiple, otherwise select 'Next'

11. THIS STEP IS ONLY APPLICABLE TO USERS WITH DOMAINS WHICH ARE RUNNING 
MULTIPLE EXCHANGE SERVERS.

If your domain has multiple exchange servers installed, FAXmaker can support users on other servers as 



well. To activate this, you must enter the name of your DSA (Directory service agent). The DSA resides on
the primary domain controller (PDC), and its name is identical to the name of the PDC. So in other words,
enter the name of your PDC. If you select multiple servers, FAXmaker must be installed in a shared 
directory, i.e. accessible to other users as well.

12. Setup will now prompt you for a directory name and service name. There is no need to change the 
service and directory name, however in certain cases in which you are re-installing FAXmaker, you might 
need to change the name in order not to conflict with the previous FAXmaker service names. 

13. Setup will now ask you where you want FAXmaker to be installed FAXmaker will need approx. 15 
megabytes of free hard disc space. In addition to this you must reserve approximately 100 Mbytes for 
temporary fax files. (depending on the amount of users you have on your server)

14. Setup will now prompt you where to copy the client setup programs. The client setup program installs 
the fax printer driver and fax viewer on the user's PC. The location where you copy the client setup 
programs should be accessible to all users. Please make note of this directory because users often forget
where the client install programs where copied by Setup.

15. The setup program will now copy all program files.

16. FAXmaker setup will now prompt you for a FAX service name. There is no need to change the service 
name, however in certain cases in which you are re-installing FAXmaker, you might need to change the 
name in order not to conflict with the previous FAXmaker service names. Click OK to continue.

I To de-install a service, you must delete all references to it from the registry and re-boot. 

.17. Setup will now finish the installation by creating a FAXmaker program group. This program group 
includes a number of applets (small applications) which you need to run to complete the installation of 
FAXmaker for Exchange.

18. Setup is now ready copying the files and modifying the registry. To complete the installation and start 
the operation of FAXmaker for Exchange, you must follow the steps outlined below.



Steps to complete installation
Step 1: Reboot your PC
Step 2: Install the FAXmaker Printer driver
Step 3: Configure the FAX server
Step 4: Configure the users
Step 5: Start the FAXmaker Gateway service
Step 6: Start the FAX server program



Step 1: Reboot your PC
Reboot your PC. This is necessary for the printer driver to be installed.



Step 2: Install the FAXmaker Printer driver
You need to install the printer driver as described in the readme, or in the Chapter 'Installing the client 
software' of this manual.



Step 3: Configure the FAX server
Configure the fax server. You need to setup at least one port (modem or fax board) to start the fax server. 
This is done using the Fax server configuration applet, located in the FAXmaker program group. The first 
time you start it, it will scan your PC for installed modems. You must have at least one class 2 or class 1 
modem installed. If you have an ISDN card, you must cancel the detection process. The fax server 
configuration utility will automatically start, after which you must click 'Add'. Now select 'ISDN controller' 
from the list of available devices. If you have a Gammalink card, you must cancel the detection process. 
The fax server configuration utility will automatically start, after which you must click 'Add'. Now select 
'Line 1' from the list of available devices. The gammalink driver will be installed.

After FAXmaker detects a class 2 modem, it will automatically configure the port for you with default 
settings. Accept these for now and close the Fax server configuration applet. For more information on the 
fax server configuration applet, consult the Chapter 'Fax server' in this manual.

I If you are using an ISDN or a Gammalink card, check the website (http://www.gfifax.com) for special 
notes on which drivers to use with these cards.



Step 4: Configure the users
The fourth step is to activate a number of Exchange users as FAXmaker users, so that they are allowed 
to send and receive faxes. This is done from the FAXmaker connector dialog, located in the Exchange 
administrator. The first time you doubleclick on the FAXmaker connector, FAXmaker will automatically 
scan the exchange users (This may take some time ) and set default settings per user. For more 
information on setting up the users, please consult the chapter 'User setup'.



Step 5: Start the FAXmaker Gateway service
You can now start the FAXmaker Exchange gateway service. This program will communicate with 
Exchange server and check for outgoing and incoming faxes and distribute them to the fax server or the 
users respectively. You can start this program as a service from the services applet in the control panel.

I If you have not entered an administrator account or a valid equivalent (with administrator rights in NT 
server and in Exchange server), the services will not start because they will not be allowed to do so by 
Windows NT server.

I To have the FAXmaker Fax service and FAXmaker Exchange gateway service start up automatically, 
change the Startup type setting to 'Automatic'. Make sure however that the FAXmaker gateway service is 
started after Exchange server itself.



Step 6: Start the FAX server program
Start the FAXmaker fax server. This program handles the sending and receiving of faxes on one or more 
ports. You can start as a service from the services applet in the control panel.

You can monitor the fax server using the FAXmaker monitor, which displays port activity and modem 
status.

I If you want to run the FAXmaker Fax server as a service, you must enter an account that has rights to 
log on as a service. This is done by highlighting the FAXmaker Fax server service and clicking 'Startup'.

I If for some reason you wish to run the fax service on a different machine on the network, you can do so. 
Please check the chapter ' Fax server' for more information on this.



Installation of the OCR routing module
THIS SECTION IS ONLY APPLICABLE TO FAXMAKER USERS WHO HAVE PURCHASED THE OCR 
MODULE.

FAXmaker users can opt to purchase an OCR module, that can automatically route incoming faxes to the 
right recipient. With this module, the fax server will scan the incoming fax for a recipient name, and if it 
finds a recipient's name, FAXmaker will automatically route that fax to the recipient's mailbox.

The module includes 2 OCR support disks, as well as a revised serial number. 

To install the module, run a:\setup.exe from the file run command in the Program manager menu. 

Follow the instructions explained during the installation. 

You will now be able to setup OCR routing per user from the Exchange administrator, by going to the 
"OCR tab" in the routing setup.



Introduction
The setup of the FAXmaker users is done from the Exchange Administrator. The person who is authorised
to supervise the system can add or delete FAXmaker users and administer their settings. 

After FAXmaker has been installed, a new directory objects has been added to the Exchange 
administrator;

It is located in connections, which is a sub branch under your domain name.



Registration
Before you setup the users, enter your serial number in the options tab. This serial number will also allow 
you to upgrade to more users or add additional modules. To read more about the upgrade options of 
FAXmaker, please visit our web site at http://www.gfifax.com.

To enter the serial number;

1. Double-click on your domain name in the Exchange administrator.

2. Double-click on 'connections'. In the right pain, the FAXmaker directory is listed. (The exact name may 
differ, because you specify it during installation.) 

3. Double-click on the FAXmaker directory object.

The FAXmaker directory property dialog appears. Go to the options tab. enter the registration number at 
the top of the dialog. Click OK to continue.

Note; If you are evaluating FAXmaker for Exchange, leave this field empty and test FAXmaker with 2 
Exchange users maximum. (This is done by disabling Exchange users as FAXmaker users.)



User settings
To setup up the FAXmaker users from the Exchange administrator;

1. Double-click on your domain name in the Exchange administrator.

2. Double-click on 'connections'. In the right pain, the FAXmaker directory is listed. (The exact name may 
differ, because you specify it during installation.) 

3. Double-click on the FAXmaker directory.

The FAXmaker directory properties dialog appears. This dialog has 4 tabs; General, Address Space, 
Options, Users

To setup users, go to the users tab. To setup a user, highlight his/her name with the mouse and select the 
appropriate settings;

More:
General Options
Send Options



Receive Options
Routing
Call blocking
Coverpages & Templates



General Options
FAXmaker user - This option will effectively enable or disable the user as a FAXmaker user. If you have 
more Exchange users than the number of FAXmaker users licensed, you must disable users.

Permission to configure settings remotely - This option will allow the user to change coverpage, 
faxheader and send resolution by sending mail to the faxadmin. (See the chapter on Remote 
administration for more information)



Send Options
Normal resolution/High resolution - Select the default resolution to send faxes in. This option can be 
overridden by specifying a different resolution in the body of the message. (See fax options in the 
"Sending faxes" chapter).

Personal FAX header - activating this option will include the sender's name on top of the FAX. This will 
allow recipients of the FAX to identify the sender. 



Receive Options
Receive incoming faxes - This option specifies that this user must receive incoming faxes, so that 
she/he can route faxes to the right users.

Include/Exclude routed faxes - When receiving all incoming faxes in one mailbox, this option allows you
to specify whether to include or exclude faxes for which a recipient already has been found, using 
available routing methods.



Routing
Routing refers to the ability of FAXmaker to automatically route an incoming fax to the right person. There 
are a number of ways to achieve this;

CSID routing - this method relies on the FAX ID which each FAX machine/FAX card displays when 
sending a FAX. Since it rarely changes, it can be used to identify the sender and thus the corresponding 
recipient. 

Routing a fax using the FAX ID (CSID)

You can setup CSID routing by adding CSIDs (FAX IDs) to a user's CSID list. FAXmaker will then route 
incoming faxes with that particular CSID to that user.

Automatic Updating of the user's CSID list.

Activating the option 'Store CSIDs of all outgoing faxes in list' will automatically update the user's CSID 
list. Each time a user sends a fax, the CSID of the recipient(s) will be stored in the CSID list. This 
technique relies on the fact that if a user sends a fax to a particular fax machine, he is likely to be the 
recipient of the answer to the fax. If you enable this option, each time the user sends a fax, the CSID of 
the receiving fax is stored in the user's CSID database.

DTMF routing - DTMF (Dual Tone Multi Frequency) tones are the tones generated by a telephone 
handset, and can be used to identify a recipient. The DTMF number can be appended after the regular 
fax number. The system works in the following way: the caller dials the fax number and waits until the call 
is answered. The fax card will now transmit a tone, after which the caller must enter the DTMF routing 
number. The FAXmaker server will recognise the DTMF number and use it to identify the recipient of the 
fax.

DTMF routing can work well, if you explain your callers how to use it. This can be done on the FAX 
coverpage of outgoing faxes. DTMF routing can also be used behind a PBX which supports DID. In this 
case you can use excess DID lines from the PBX to route the FAX to an extension.

Routing a fax using DTMF/DID routing

DID routing (Direct Inward Dial) - DID routing is generally considered the most reliable form of 
automatic inbound routing, because it relies on information provided by the telephone exchange, not on 
information provided by the caller. DID requires you to purchase 'virtual phone numbers' from your 
telecom company, which you can assign to users or departments. The virtual phone number (DID 
number) will be passed to FAXmaker so that FAXmaker knows to whom the fax should be routed. A DID 
number is passed using either a PBX with DID capability, or a fax card with DID as a DID device. These 



devices must pass the DID number to FAXmaker as a series of DTMF tones. The system is completely 
transparent to the caller and does not require any effort on his part.    

To setup both DID and DTMF routing, click on the 'Routing-Setup' button. Then go to the DID/DTMF tab in
the routing dialog. Fill in an appropriate routing code for the user. Remember that actual activation of DID 
or DTMF routing is done in the FAX server. The administrator only stores the users' routing code. The 
same routing code can be used for both DID or DTMF routing.

I If you are going to use an ISDN card to perform DID routing, please refer to the 'FAX server' Chapter for
more information how to setup this up

OCR routing - OPTIONAL MODULE - Another easy way to route faxes automatically is using OCR. This 
system will OCR the first page of a fax, and consequently search the fax for a recipient name. If it finds 
one, it will route it to the recipients mailbox. This option requires the optional OCR module.

Routing a fax using OCR

To setup OCR routing, click the OCR setup button in the Routing tab. This dialog has two tabs:

1.    Greeting - meaning that the FAX server will search for a greeting such as Dear, Mr., Ms., etc., before 
the actual user name. This means that the FAX server will only attempt to recognise a user name after it 
has recognised a    greeting word. You can add and remove greetings by clicking the add and remove 
buttons. You can enter a matching ratio, or confidence level in the edit box. This allows you to specify the 
confidence FAXmaker must have before it will actually recognise it as a greeting. Using this option you 
can tune the system to your specific needs. For normal use, a low setting is required, since greetings are 
short, and a lower matching ratio allows for OCR mistakes, and for 'spelling mistakes'.

2.    User keywords - here you can enter keywords per user, which FAXmaker will search for to identify the
recipient of a FAX. If, for example, an individual Mr. Johnson, is also known as John, this keyword may be
entered also, as well as Mr. Johnson. In addition, if Mr. Johnson is responsible for international sales, one 
might add international sales as a keyword too. A matching ratio can be entered to tune the system. 



Call blocking
Call blocking allows you to exercise control over the fax numbers that the users can send to. To enable 
this option, activate the radio box. You can now add numbers to the list which may not be dialled by the 
user. FAXmaker will check the list before each fax transmission, and not send any faxes starting with 
numbers listed in the call blocking list. This means that if you want to disallow certain users making 
international fax transmissions, you only need to insert the international dial out number (for example 00, 
09 or 011). Alternatively you can block specific fax-numbers. 



Coverpages & Templates
A number of coverpages and templates can be used for sending faxes. The administrator can do this from
the Coverpage and Template properties dialog. Users can also change coverpage and templates from the
client (see chapters 'Sending and receiving faxes' and 'Remote Administration').

Difference between a coverpage and a template

A coverpage is inserted in front of a fax, whereas a template is the format or lay-out of the actual fax 
message. This means that by designing a template with a letter head and fields, you could eliminate the 
use of a coverpage (see also chapter 'Designing CoverPages &    Templates').

Whether you use a template or coverpage or both is up to you to decide.

Adding templates or coverpages

FAXmaker ships with a number of sample templates and coverpages. By default, FAXmaker will use the 
file template.rtf (located in the Faxmaker-coverpge subdirectory) as a template for all users.

By modifying template.rtf you can avoid configuring a template file for each user. 

To add a custom coverpage or template:

1. Design your coverpage/template in your word processor and save it as an RTF (Rich Text format) file 
(i.e. with extension '.rtf'). For more information on designing a coverpage/template, turn to the chapter 



'Designing Coverpages & Templates'.

2. Click 'Add' and select the RTF file you created.

3. If you wish to set this RTF file as the default, click 'Set Default'.



Introduction
The Fax server program is the core of FAXmaker. It is fully multi tasking and can handle sending and 
receiving of faxes simultaneously (If you have multiple fax modems). The Fax Server can run as an 
application or as a service. Setup of the Fax server is performed from the FAXmaker 'Fax Server 
Configuration' applet.



Registration
Before you setup the fax server, enter your registration number in the register dialog. This registration 
number will also allow you to upgrade to more users or add additional modules. To read more about the 
upgrade options of FAXmaker, please visit our web site at http://www.gfifax.com.

To enter the registration number;

1. Click on 'Register '.

2. Enter your company name and registration number Click 'OK' to continue.

I If you are evaluating FAXmaker for Networks, leave this field empty and test FAXmaker with a 
maximum of two-users.

I Please take some time to register your product using the WWW form on our site: 
http://www.gfifax.com/pages/regfrm.htm. This will also allow you to request support.



Configuring the Fax Server
Before you start the Fax Server, you must configure the 'Ports' that you will be using in the Fax server. A 
port is a COM port with a modem attached or a fax line on a fax/ISDN board. To configure a port:

1.    Start up FAXmaker's 'Fax Server Configuration' applet.

The first time you start it, it will automatically scan your PC for an available port. You can cancel this 
process by clicking 'Cancel'.

FAXmaker will try to detect a modem installed on your PC. After it finds a modem, it will ask you whether 
you wish to install it. Select Yes. You can now cancel the auto-detect process, unless you wish FAXmaker 
to scan for more modems.

If you are using an ISDN or Gammalink card, cancel the autodetect process. The 'Fax Server 
Configuration' utility will automatically be displayed. Now select 'Add'. You will be able to select from a list 
of compatible fax devices. If you are using an ISDN card, select ISDN controller. If you are using a 
Gammalink card, select 'Line 1'. The setup for the cards will appear automatically.

I If you have cancelled the scanning of ports earlier, or have installed an additional modem or board, you 
can select 'Add' to restart the scanning process. You will be able to choose from a list of fax devices.

I You can change the port settings by double-clicking on a port or selecting a port and clicking 'Properties'.

2. A tabbed dialog will appear, which allows you to specify modem, fax, printing, routing and archive 
options for that port. If you have OCR installed, an OCR tab will also appear.

More:
Modem Properties
Fax Setup
Routing
Autoprint incoming faxes
Archive



Modem Properties
This tab allows you to configure your modem. 

Modem control

Modem type - Select your modem from the drop down list box.

Initialisation string - Although the initialisation string does usually not need to be changed, you can edit 
the string in this field.

Line options

Tone dialling - Activate this check box if you can use tone dialling. If you deactivate it, the Fax server will 
use pulse dialling. 

Wait for dial tone - If you activate this option, the fax server will only send the fax if the modem detects a 
dial tone. 

I Some export modems do not recognise the dial tone, so you must first test whether your modem 
recognises a dial tone. If it does not, deactivate this option.

Check for busy tone - Activate this option if you want the modem to check for a busy tone.

Speaker mode - Select whether you want the speaker to be 'Always Off', or 'On until connected' or 
'Always On'.

Speaker volume - Select the appropriate volume. 



Fax Setup
General options

Maximum Speed - Select the send and    receive speed according to your modem's capabilities. 
Remember that not all modems are able to negotiate "down" well, so choose 9600 if in doubt.

Local ID- Enter the fax ID. The recipient will see this as the identification code of the fax.

Send options

Send outgoing faxes - This radio box allows you to determine whether this port/modem should send 
faxes. This is useful when you want to use one port or modem for receiving faxes only.

Dial prefix - If your lines are located behind a PBX, you can specify a dial prefix here.

Number of retries - Sets the number of times FAXmaker will try to send a fax.

Retry delay - This option allows you to set a delay between retries in seconds.

Fax header - The fax header is a word or company name which will appear on top of each fax.

Receive options

Answer incoming calls - For the fax server to be able to receive faxes, this option must be checked. 
Specify after how many rings you want FAXmaker to answer in the 'Rings until answer field'.

Attach OCR document - If you have the OCR module installed, you can select this option to have the 
OCR text output attached to the incoming fax.

Incoming call detection - By default the fax server will answer all incoming calls as fax only. However, if 
you have installed the voice mail or Fax on demand module (optional module), you can have the fax 
server detect between fax/voice or voice only calls. 



Routing
Inbound routing of faxes is set up in the 'User Configuration' applet, however you must activate the 
various routing methods in the server in the 'Routing properties' tab. Activate a routing method by clicking 
on the appropriate radio box.

I Do not enable DTMF/DID routing unless you have a compatible voice modem or a compatible ISDN 
card correctly setup. Compatible voice modems are Zyxel or modems that have a Rockwell voice chipset.
You must also select the corresponding driver in Modem properties as either Voice modem (Rockwell) or 
Zyxel. If you enable DTMF routing without having a voice modem or an ISDN card, the fax server will 
generate an error whilst receiving.

DTMF/DID options

Generate beep - you can instruct the Fax server to generate a beep when it picks up the line. This will 
alert the caller or PBX to enter the DTMF string.

Number of digits - Length of DTMF string/number that caller or PBX must generate.



Autoprint incoming faxes
The printing options dialog allows you to configure automatic printing per port. That is, you can select 
either the same or different printers to service the printing requests from various ports. Both incoming and
outgoing faxes can be printed automatically. Printing of outgoing faxes is configured in the general setup 
because it is not port specific.



Archive
This tab allows you to specify the archive options. Archiving allows you to create a backup of all incoming 
and outgoing faxes.

If you have the OCR module installed, FAXmaker will store the OCR text output in the same directory, 
using the same file name as the corresponding fax file, but using extension *.txt instead of *.fax.

Archive incoming - Archives all incoming faxes in a directory of your choice.

Archive outgoing - Archives all outgoing faxes in a directory of your choice.



Configuring an ISDN card
Skip this paragraph if you do not have an ISDN CAPI 2.0 card. 

The setup of the ISDN card is quite similar to the setup of a modem. 

More:
ISDN card send receive options
MSN number setup
Configuring routing with ISDN



ISDN card send receive options
First of all select the appropriate ISDN card from the list of available ISDN card drivers. Because the 
currently available cards differ in their specifications, some send and receive options may not be 
applicable to your card. For the latest information regarding ISDN cards and FAXmaker, please check our 
web site http://www.gfifax.com.



MSN number setup
You must specify which MSN numbers FAXmaker must answer. For example, if you wish that FAXmaker 
only answers the number 040-306810-10, then you must enter it here. 

I If you do not enter any number here at all, FAXmaker will not answer incoming calls!

If you wish that FAXmaker answers a whole range of numbers (for example if you are using DID routing), 
just enter the starting number of the range of numbers. For example: to instruct FAXmaker to answer all 
numbers 306810-10 up to 306810-19, enter '306810-1' in the MSN number setup dialog.



Configuring routing with ISDN
After configuring the MSN numbers, you can setup automatic routing of faxes. This is done using the DID 
routing feature. (In the UK, DID is referred to as DDI). To configure routing with ISDN;

1. Make sure the MSN numbers have been entered.

2. Switch on DTMF/DID routing in the routing tab.

3. Specify the number of digits that FAXmaker should use. For example if your DID numbers are 306810-
10 to 306810-19, then specify 2 digits. This means that FAXmaker will only 'analyse' the last two digits of 
the number and try to match it with a user's DTMF/DID routing number. This number is entered in the 
'User Configuration' utility, in the routing tab.



Configuring a Gammalink card
Skip this paragraph if you are not using a Gammalink card. 

To add a Gammalink card, simply select 'Line 1' from the list of compatible fax devices. This will 
automatically add the Gammalink driver. A tabbed dialog will appear in which you have the same fax, 
OCR, routing, call blocking and archiving options as for modems. For more information on these settings 
please see the first part of this chapter.



RTF converter setup
The RTF converter converts coverpages and e-mail messages to fax, using a customisable RTF file as a 
template. The converter options are changed from the 'Fax Server Configuration' applet. 

To change RTF conversion options:

1. Click the RTF setup button at the bottom of the list of ports.

2. A dialog appears which allows you to specify the margins that you wish to use. It is important to take 
these margins into account when designing your cover page.

3. The default page size cannot be changed. The list box has been included to indicate that you must set 
the page size of your RTF template to 81/2 by 11 inches. (Standard US size) This will in no way effect 
your fax transmissions.    



General options
The general setup contains general options which are not specific to a port. To change general options;

1. Click the general button next to the list of ports.

2. A dialog appears which allows you to specify general options;

More:
Autoprint outgoing faxes
Scan directory for text files



Autoprint outgoing faxes
Autoprint outgoing faxes    - This option automatically prints all faxes that are sent successfully. You can
select a printer on which all faxes from the list box will be automatically printed.

Print report if successful - If this option is activated, FAXmaker will print a transmission report and a 
miniature of the fax after successfully sending a fax. You can also specify how many pages you wish 
FAXmaker to include in the miniature print out (maximum of 4 pages).



Scan directory for text files
This option allows you to send faxes programmatically, by posting a correctly formatted text file in the 
'scan directory'. In this way you can integrate FAXmaker with a Web server, and allow a custom CGI 
script to send a fax automatically.

To send out a text file automatically:

1. Create a text file with your message text in it.

2. Add a line at the top of the text, starting with a double colon ::, specifying the recipients name (optional)
and company and the fax number. For example:

::Mr Johnson, GFI, 661072

3. You can add additional send options by adding a second line, preceded by a double colon, specifying 
valid send options as described in the 'Sending and Receiving Faxes' chapter.

If the fax is transmitted successfully, the extension of the fax file name will be changed to *.suc. If the fax 
has failed, the extension will be changed to *.err. This allows you to give feedback to the user of your 
program.

Text files are formatted using an rtf file as a template. This way you can add your company logo and 
address details etc. to the text file. The rtf file is called txttmpl.rtf and is located in the coverpage directory. 
To change this template, simply edit txttmpl.rtf and save it with the same name in the same directory.



Configuring the ActiveX document converter
FAXmaker is able to convert Office 95/97 and other attachments such, using its document converter 
interface. 

More:
Requirements of the document converter
Adding additional formats



Requirements of the document converter
· FAXmaker must be running on Windows NT 4.

· Microsoft Office 97/95 must be installed on the Exchange/Fax server computer.

· The FAX server must be run as a desktop application, i.e. not as a service. This is required because a
service cannot interact with an application. To do this, run the FAXmaker fax server with the -desktop 
option from the console (NT command prompt).



Adding additional formats
To add additional formats, you must write a script that interfaces with the active X objects of the custom 
application that you wish to add. For more information on how to do this, consult GFI or check the GFI 
FAX & VOICE website for more sample scripts.



US date format in fax header
The FAXmaker fax header is as default set to the European date format. 

To make the FAX header appear in US date format;

Open the fgwmserv.ini file (located in the Windows NT directory) with notepad, and search for;

UsaDateFormat=0/1

To switch on US date format, set the value to one. This setting should be changed for each COM port.



The FAX Server Monitor
The 'Fax server monitor' allows you to monitor the status of the fax server. The top pane shows the 
activity on each of the ports, and the bottom pane displays a detailed error log.

The 'Fax server monitor' can be started from another PC as well, however the error log will not be listed.

More:
Aborting a fax



Aborting a fax
To abort a fax, select the appropriate port and choose 'Abort' from the port menu.



The Queue view utility
FAXmaker includes a queue view utility which allows you to see which faxes are queued to be sent at the 
server level. When a fax has been submitted to be sent, the only way to delete it is using this queue view 
utility! The queue view utility can be started from the FAXmaker for Networks server program group.



Running the fax server as an application
The FAXmaker fax server can be run as an application from the FAXmaker program group or as a service
from the services applet.

The FAXmaker fax server can also be run from the console/command prompt by specifying <-desktop>. 
For example;

fgwmserv -desktop

This will start the FAXmaker fax server as an application and allow you to quickly start and stop the fax 
server.



Running the fax service on another machine than exchange 
server
The PC's workload can be decreased by separating FAXmaker for Exchange onto two servers; The 
Exchange gateway service running on the Exchange server and the fax service running on a separate NT
machine, the fax server. Separating the workload is normally not necessary, but can be done if the 
customer wishes to do so.



Steps to separate workload;
1. Ensure you have a second NT machine, effectively the fax server, which will be running the fax service.
This fax server must be running Windows NT workstation 3.51 or 4, or NT server 3.51 or 4. For NT 
workstation, a minimum of 16 MB must be installed, for NT server a minimum of 32 MB memory. The 
modems must be installed on this machine.

2. Install and configure FAXmaker for Exchange as described in the manual on the Exchange server 
machine. When FAXmaker is running satisfactorily, start the "separation process".

3. Stop the fax and gateway service on the exchange server machine if it is still running.

4. Install the fax client on the fax server machine. Afterwards, install the FAXmaker printer driver on the 
client machine.

5. Copy the entire FAXmaker directory to the fax server machine that will be running the fax service. DO 
NOT USE A DIRECTORY NAME ON THE FAX SERVER MACHINE DIFFERENT THAN THE ONE USED
ON THE EXCHANGE SERVER ( eg. C:\FAXMAKER on both Exchange and fax servers). 

6. Share the entire FAXmaker directory on the fax server machine (ie. share C:\FAXMAKER ).

7. On the Exchange server machine, make a drive mapping to the FAXmaker directory located on the fax 
server machine. This drive mapping will be used to tell the exchange service where to store the in-going 
and outgoing faxes. |(eg. Map fax server machine F:\ on exchange server) 

8. Now install the FAXmaker fax service on the fax server machine. This is the way it should be done: 

9. If you are using the same version of Windows NT (eg. both version 3.51 or both version 4.0) 

a) start up the registry    on exchange server (by running    the command REGEDT32. 

b) Select the 'HKEY_CURRENT_MACHINE on local machine ' window. 

c) Select and open 'HKEY_CURRENT_MACHINE' , then select and open 'SYSTEM', select and 
open 'CURRENTCONTROLSET', select and open 'SERVICES', and finally select 'FAXmaker FAX 
service' and high light it. 

d) Open Registry menu (by mouse or ALT-R) and choose 'Save Key..'. Name and save under the drive 
which is mapping fax server ( eg. save as F:\FAXMAKER\fax.). 

e) go to the fax server and run registry as in (a).

f) Select and open the same options as above 'HKEY_CURRENT_MACHINE' ,'SYSTEM',    
'CURRENTCONTROLSET', 'SERVICES'    and then select Edit Menu ( ALT-E) and choose 'Add Key..' 
name key 'FAXmaker FAX service' . 

g) Select the newly created    key (FAXmaker FAX service) and choose Registry menu (ALT-R). 

h) Select 'Restore..' and write name of file you saved before, this time in the server drive (eg. c:\
FAXMAKER\fax).

I) Reboot the computer. The FAXmaker fax service is now installed on the fax server.

If you are NOT using the same version of Windows NT (eg. one version 3.51 and the other version 4.0) 
save the registry file from a same version of Windows NT of the fax server. Then continue from    
procedure (e) above.

10. From the Windows NT directory of the exchange server copy FGWADDR.INI to the Windows NT 



directory on the fax server. Furthermore, you must copy FGWMSERV.INI from Windows\FAXmaker 
directory to Windows\FAXmaker on server machine.

11. Now install the FAXmaker printer driver on the fax server machine also as described in the readme

12. Configure FAXmaker on the fax server (eg. modems), by starting fgwconfg.exe on the fax server 
machine (located in the FAXmaker directory)

13. Start up the Exchange administrator on the Exchange server machine and go to the FAXmaker 
connector

14. Go to the options tab and change the location of the in and out directories to the directories on the fax 
server machine (You made a mapping earlier to this directories, eg. F:\FAXMAKER\IN and F:\
FAXMAKER\OUT)

15. Start the FAXmaker fax service on the fax server machine. Restart the gateway service on the 
Exchange server machine.

You should now be able to send and receive faxes using the second fax server machine.

NOTE: Any changes to the user setup will require that you copy the all FGWADDR.INI and 
FGWMSERV.INI to the fax server machine. If you make any changes to the fax server setup, make 
sure you do it on the fax server machine.



Introduction 
After installing the Fax server, you can already send faxes by typing the message in the e-mail program. 
However if users wish to send faxes directly from their Windows applications, or wish to view their 
incoming faxes using the FAXmaker viewer, they must run a setup program from their machine first. This 
installation procedure is described below.

The setup program installs the printer driver and the viewer on the user's machine.



Installing Windows 3.1 or 3.11 clients
1.    Run <setup.exe>, located in the install\win 3.1 directory located under the install directory, by using 
the 'Run' command from the 'File' menu in Program Manager. The exact location of the client setup 
programs was determined by the administrator during initial FAXmaker setup. (If in doubt, contact your 
administrator to find out from where to install the FAXmaker client).

2.    Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of 
files to the directory Faxmaker, located under your Windows directory.

3. Reboot your machine after completing the installation.



Installing Windows 95 clients
1.    Run <setup.exe> located in install\win95 directory by using the 'Run' command from the 'File' menu in
Program Manager.

2.    Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of 
files to the directory Faxmaker, located under your Windows directory.

3. FAXmaker setup will ask you which viewer you wish to use to view faxes. FAXmaker includes a 
standard fax viewer, but if you have WANG imaging installed on Windows 95, FAXmaker can offer 
advanced viewing facilities such as Annotation.

Setup asks which fax-viewer you would like to install.

The WANG imaging viewer is available for Windows 95 & NT4. It can be downloaded free of charge from 
http://www.wang.com and http://www.microsoft.com.

In later versions of Windows 95 and in Windows NT 4, the Wang imaging viewer is an installation option. 
Before selecting the advanced viewer check whether you have Wang imaging installed.

4.    Reboot your machine after completing the installation.



Installing Windows NT 3.51 clients
1.    Run <setup.exe> located in the \install\winNT35 directory by using the 'Run' command from the 'File' 
menu in Program Manager.

2.    Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of 
files to the directory Faxmaker, located under your Windows directory.

3.    Reboot your machine after completing the installation.

More:
Installing the Windows NT 3.51 fax printer driver



Installing the Windows NT 3.51 fax printer driver
After running the FAXmaker Windows NT Install program & rebooting your machine, you must install the 
fax printer driver from the Print Manager. 

To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print 
Operators, or Power Users group. 
1. Start the Print Manager from the Control Panel or Main group.

2. From the Printer menu, choose 'Create Printer'.

3. In the Printer Name box, type FAXmaker.

4. Install the FAXmaker printer driver: in the 'Printer Properties' dialog box, select 'Other' in the Driver box.

5. In the 'Install Driver' dialog box, specify the drive and path where the FAXmaker\install\client\winnt\
winnt35 directory is located, for example:

FAXmaker\install\client\winnt\winnt35 and choose the 'OK' button. 

6. In the Select Driver dialog box, select the FAXmaker driver. Then choose the 'OK' button. 

7. The driver will now be installed by FAXmaker. 

8. In the Driver box, select the FAXmaker printer driver 'FAXmaker'. 

9. In the 'Print To' box, select 'GFIFAX:'. (This port should have been automatically added after you 
rebooted the system). 

10. In the 'Create Printer' dialog box, choose the 'OK' button. 

11. This completes a basic printer installation. Once a driver is installed, Print Manager automatically 
displays a dialog box allowing you to set up the features of your printer. There is no need to change any 
of these options. 



Installing the Windows NT 4.0 clients
1.    Run <setup.exe> located in the \install\winNT40 directory by using the 'Run' command from the 'File' 
menu in Program Manager.

2.    Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of 
files to the directory Faxmaker, located under your Windows directory.

3. FAXmaker setup will ask you which viewer you wish to use to view faxes. FAXmaker includes a 
standard fax viewer, but if you have WANG imaging installed on Windows NT4 (This is part of the 
Windows NT 4 CD ROM, check Windows Setup to see if you have it installed), FAXmaker can offer 
advanced viewing facilities such as Annotation.

Setup asks which fax-viewer you would like to install.

I In Windows NT 4, the Wang imaging viewer is an installation option. Before selecting the advanced 
viewer check whether you have Wang imaging installed.

4. Reboot your machine after completing the installation.

More:
Installing the Windows NT 4 fax printer driver



Installing the Windows NT 4 fax printer driver
After running the FAXmaker Windows NT Install program, you must install the fax printer driver from the 
Print Manager. 

To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print 
Operators, or Power Users group. 

Go to the 'Add printer' wizard located in the 'Printers folder' in the control panel.

I You may need your Windows NT 4 install disks at hand.

1. Start 'Add Printer'

2. Select 'My Computer'

3. Select 'Next'

4. Select 'GFIFAX' from available ports list. This port will only appear after running the client installation 
and rebooting your machine after installation.

5. Select 'Next'.

6. The printer selection dialog will appear. Select 'Have Disk'

7. Enter the path to the FAXmaker NT driver directory; namely FAXmaker\client\winnt\winnt4.

8. Choose 'OK'

9. Verify FAXmaker printer driver appears in Printer dialog.

10. Choose 'Next'.

11. The 'Add Printer' wizard will prompt you to insert the Windows NT 4 CD ROM. However, if you have 
an English installation, you can simply delete i386 from the path that is prompted' and use the files 
supplied by the FAXmaker install. (NOT RECOMMENDED, USE NT INSTALLATION DISKS IF 
POSSIBLE.)

Click 'OK' to continue.

12. You may choose to use FAXmaker as your default printer driver.

13. Click 'Next'.

14. Choose 'Not shared'.

15. Click 'Next'.

16. Do not print a test page.

17. Choose 'Finish'.



Introduction
This chapter is meant for users of FAXmaker who wish to tune their FAXmaker installation and get to 
know all its features.



Personalised Fax broadcasting (fax mail-merge)
FAXmaker is able to send out personalised fax broadcasts using the Mail merge feature of Microsoft 
Word 95 and 97.

To use this feature, you must prepare a data file which includes the recipient details and their fax number 
formatted in a particular way.

More:
Preparing the data source
Performing the mailmerge



Preparing the data source
The data source (the list of recipients) that you are going to use (since Word can use ODBC you can 
access almost any datasource), must contain a field for each record with the fax/email address. The email
address must be a one-off    FAXmaker address, written in the following way; [FAXmaker:23456]. There is 
no need to display this field in the word document, but it must be present in the datasource, so you can 
instruct Word to merge to the faxserver email address.

If you wish to add a coverpage to the fax which must include recipient name and company name, you 
must include this information in the FAXmaker address as well. To do this format the address in the 
following way;

[FAXmaker:name@company@number]

for example;

[FAXmaker:support@gfifax@011356340760]



Performing the mailmerge
To perform the fax mail merge;

1. Start up Microsoft Word and select 'Mail merge' from the tools menu. Create the mail merge as you 
normally would in Word. If you are not sure how to use Word mail merge, check the Microsoft Word help.
The MS Word    mail merge helper

2. After you have created your main document and accessed the data, you can proceed to perform the 
mail merge. Instead of printing it to a printer, the mail merge must be merged to 'Electronic Mail'. To do 
this, click on 'Merge', and in the 'Merge to' dialog box, select 'Electronic mail'.

Merge to Electronic mail

3 Now click on 'Setup'. Here you must set a number of options for the mail merge. 

Mail merge setup dialog.

In this dialog you must select the field that includes the email/fax address. In addition, one must select 
'Send document as attachment', which creates an individual Word document for each attachment. The 
subject line setting can be ignored.

Click 'OK' and perform the merge. Word will send a personalised document to the FAXmaker gateway. 
FAXmaker will convert the document to fax and send it out to the specified fax number.



Fax server error messages
2000: Error 2000 means: look in Windows NT Event Log for a description. You can also see the 
description in the FAXmaker Monitor application.

More:
RTF2FAX Errors
FAX Server errors



RTF2FAX Errors
Errors relating to the rtf/text/document to fax conversion;

1600    Open File Failed

1601    File not found

1602    Read file failed

1603    Conversion failed

1604    Fax recovery/conversion failed

1605    Already initialised (should never happen!)

1606    Initialisation failed

1607    Coverpage does not exist

1608    The specified Rich text file is not valid

1609    An Unknown error occurred



FAX Server errors
Errors relating to the fax server;

2000    Unable to start the FAX Service. Complete description of the error is given in the Event-Log 

3000L Invalid window parameter in Open Line

3001L Memory allocation failed

3002L Driver module not found

3003L Driver does not support required functions

3004L Invalid window parameter in Open Line

3030L Invalid line ID

3031L Function not supported by the driver

3032L Another task still active on the line

3033L PostThreadMessage failed

3100L Task was aborted with AbortTask

3101L ERROR response from device

3102L No response from device

3210L Unable to find CAPI2032.DLL

3211L ISDN controller not found

3212L CAPI Register failed

3213L Board initialisation failed

3214L Line not available

3215L Invalid line

3510L Board initialisation failed

3610L Board initialisation failed

3710L Class 1 only

3711L No fax on demand

3910L Board initialisation failed

3911L Board Submit receive failed

3912L Unable to listen for a connection

Sending errors

4110L Invalid format       

4111L Open file failed

4112L Read file failed    

4113L Creation of tempfile failed

4114L Call Failed



4115L No dial tone

4116L Busy tone

4117L No Answer

4118L Voice detected

4119L Handshake failed

4120L uWaitDigits or uMaxDuration timed out

4121L Unable to retry a page because page could not be found

4122L AT+FET error

4123L Disconnection failed

4140L CAPI failed

4141L CAPI call setup error

4142L CAPI call failed

4143L CAPI call broken

4160L Board initialisation failed

4161L Board submit sending failed

Receiving errors

4210L File Creation failed

4211L No carrier. Happens during receive fax when remote caller is voice or when remote caller 
disconnects immediately. No carrier occurs only at the beginning, before 'FCON' is received

4212L Handshake failed

4213L Write file failed

4214L AT+FET error

4215L uWaitDigits or uMaxDuration timed out

4230L Unable to receive fax if no connection has been established

4231L CAPI call failed

Voice play errors 

4310L Maximum digits

4311L Term digit

4320L Data/fax/voice mode is not properly set

4321L    Open file failed

4322L Invalid file format

4323L Read file failed

4324L Busy tone

4325L Fax calling tone detected

4326L Modem carrier detected



4327L Handset/line hang-up

Voice record errors

4410L Maximum silence

4411L Maximum duration

4420L Data/fax/voice mode is not properly set

4421L Invalid file format

4422L Create file failed

4423L Handset/line hang-up

4424L Transmission error    

4425L Busy tone

4426L Write file failed



Call accounting
Call costing can easily be done using Excel, Access or any other application that can read 'CSV' (comma 
separated values) files. FAXmaker logs all incoming and outgoing faxes in the following two files: 
Sendlog.txt and Rcvlog.txt. The files are located in the FAXmaker 'System' directory. Using the 
information in those files, a detailed report can be made.

More:
Send log file
Receive log file
Excel macros to analyse log file



Send log file
The following information is stored for each outgoing fax;

Date,Time,SenderEmail,SenderName,BillingCode,RemoteId,RecipientName,RecipientCompany,Recipien
tNumber,CallDuration,PagesTransferred,Result,Info,Port,FilesInArchiveDir.

For example:

"22/12/96","22:18:16","nick@gfitest","nick","","88888888","nick","gfi","nick_gfi_23 
<fax@gfitest>","00:30","1","SUCCESS","Fax has been sent successfully","COM2",""



Receive log file
The following information is stored for each incoming fax:

Date,Time,RemoteID,CallDuration,PagesReceived,Result,Info,Port,FileInArchiveDir,RoutedTo.

For example;

"21/12/96","20:14:03","88888888","00:39","1","SUCCESS","Fax 
received","COM2","","nick@gfitest,alexm@gfitest,bart@gfitest"



Excel macros to analyse log file
Registered users will be able to download a set of Excel macros from our website. These will analyse the 
FAXmaker send and receive logs. They are scheduled to be available by the end of May 1997. Please 
check our web site for availability. The macros will only be available to registered users.



Internet site http://www.gfifax.com    
Tips for using FAXmaker and further information regarding technical support can be found on our web 
site:

http://www.gfifax.com.

The web site will always have the most up to date listing of tips and support questions.

If you have a technical question, please send an e-mail to support@gfifax.com.



Introduction
FAXmaker allows you to customize your coverpages and templates.

A coverpage is inserted in front of a fax, and a template is the format or lay-out of the actual fax message.
This means that by designing a template with a letter head and fields, you could eliminate the use of a 
coverpage. Both can be used by all FAXmaker users. 

You can design your cover page or template to include your company logo, sender and recipient fields, 
message fields and any bitmap images. You could also use or customize the existing templates included 
in FAXmaker.

The administrator, but also the users themselves can store coverpages and templates, and set them 
either as defaults or use them for a particular fax. For more information see the chapter 'Remote 
administration', and 'Sending and Receiving Faxes'.



Designing a coverpage or template
FAXmaker uses a standard rich text format file as a template to create cover pages. 

The rich text format (RTF) is a standard amongst word processors and is supported by virtually any word 
processor, including MS Word, Amipro and Wordpad (included in Windows 95). This means that you can 
create your template in your favourite word processor, and just include the merge fields such as the 
recipient name, company and message text by inserting a field where you wish to have the actual 
names/information inserted. For example, to have a field recipient name filled in, include a text 
<R_name> in the coverpage template.

For example a very simple coverpage with recipient name and company could be created as follows;

To: <R_Name>

Company: <R_Company>

Supposing you want to send a fax to Pete Johnson at York computers, the fax would be sent out as 
follows:

To: Pete Johnson

Company: York Computers

The merge fields in the RTF file are replaced by the recipient information and then the coverpage is 
converted to fax format.

IThe easiest way to design a cover page is to adjust one of the samples included with FAXmaker in the 
coverpage directory. To do this simply open up one of the coverpages in your word processor, for 
example Wordpad, and move around, add or delete merge-fields and/or text as you wish. 

After you have finished designing your cover page, save the template as an RTF file and assign it to a 
user.    If you wish to make a default template for the entire company, modify the file template.rtf in the 
Faxmaker\coverpge directory.    If you use these default files, you don't need to configure a coverpage or 
template for each user individually. If you wish to make a default coverpage for the entire company, 
modify the file coverpge.rtf in the Faxmaker\coverpge directory.

TIP: Use Wordpad or MS Word to design your coverpages/templates. FAXmaker uses conversion 
technology used by these applications also, and therefore it will give you "what you see is what you get" 
(WYSIWYG).
The rtfcvt32 utility lets you quickly convert your coverpage/template and preview the result of your artistic 
efforts.

TIP: use the rtfcvt32.exe program located in the FAXmaker directory to preview your template/coverpage 
as a fax file. 



Supported merge-fields
The following merge-fields may be used in the RTF file.

More:
Sender fields:
Recipient fields
General fields
Tips on designing a cover page



Sender fields: 
These fields are replaced by the sender information, typed in the e-mail message box:
Address Fields Merge code
Last name <S_Last_name>
First name <S_First_name>
Name <S_Name>
Company <S_Company>
Department <S_Department>
E-mail <S_E-mail>
Fax <S_Fax>
Voice <S_Voice>

Recipient fields
These fields are replaced by the recipient information typed in the e-mail message box:
Addres Fields Merge code
Company <R_Company>
Name <R_Name>
Fax <R_Fax>

General fields
These fields are replaced by general information:

Message text: <message>

This field inserts the text of the coverpage as entered in the e-mail message. Be sure to leave enough 
space in the RTF file.

Current time: <time>

Current date: <date>

Long date format: <Longdate>

These fields insert the date and time of the fax. Please note that the date and time of the server machine 
will be used.

Subject: <subject>

This field inserts the subject line of the message



Tips on designing a cover page
When designing your cover page in RTF format, please take note of the following:

I To preview your coverpage as a fax, use the rtf2fax program located in the FAXmaker directory.

I Remember that RTF does not support tables and/or headers/footers.

I Remember that merge fields are replaced by the actual field values. Therefore, if you do not leave 
sufficient space, long names can mix up your formatting.
Example of a coverpage with merge- fields



Benefits of sending faxes with FAXmaker
FAXmaker allows you to send and receive faxes from your PC, without having to print the document first, 
walk to the fax machine, key in the fax number and reschedule at a later stage if the number is busy.

Instead, FAXmaker uses a FAX server computer, located on your network, which is assigned all Fax 
related jobs, and also allows you to send and receive faxes at the same time!

More:
The benefits
Ways to send a fax



The benefits
· You no longer need to print out a document prior to faxing it.

· FAXmaker will automatically retry fax numbers if they are busy.

· Your faxes are more legible and of a better quality, since they are sent directly from your PC, using 
high resolution techniques.

· Incoming faxes can be automatically routed to you as soon as they are received.

· Only you can view your outgoing and incoming faxes.

· You can easily send faxes to groups of people. 



Ways to send a fax
There are two ways to send a fax with FAXmaker:

1.    Create or open a document in any Windows application and print it on the 'FAXmaker printer'. This 
automatically activates Exchange from which you can send the fax.

 OR:

2.    Type in the text in Exchange, and send it from there.



Sending a Fax from an Application
Sending a fax from a Windows application is a simple process. You can make a document in your word 
processor or any Windows application, and then fax it using FAXmaker's printer driver. If you can print the
document in Windows, you will be able to fax it with FAXmaker. 

To fax from a Windows application, follow the following steps:

1.    Start Write/Wordpad.

2.    Enter some text or open and existing document.

3.    Choose the FAXmaker printer driver as your current printer. The FAXmaker printer driver is a 
mechanism which stores your document as a fax file. 

a.    From Write's 'File' menu, choose 'Printer Setup'. Select the FAXmaker printer driver and choose 'OK'.

4.      Print your letter.

a.    From Wordpad/Write's 'File' menu, choose 'Print'. In the 'Print' dialog box, click on 'OK'. 

b.    Immediately after the printer driver has printed your document, The Exchange client starts with the 
'Message Send Dialog'. 

5.    Click on the 'To' field to start the Exchange address book.

More:
If you are using Microsoft OUTLOOK



If you are using Microsoft OUTLOOK
FAXmaker supports the Outlook address book . This means that you can select a recipient from the 
Outlook address book rather than creating a new FAXmaker address for each recipient.

6.    Click 'New; to create a new address. Select FAXmaker address. A dialog will pop up for a name and a
fax number. Enter GFI FAX & VOICE and the fax number; 00,356-661072.

Note: IF YOU ARE USING THE PERSONAL ADDRESS BOOK AND YOU WISH TO COMPANY NAME 
AND CONTACT NAME TO APPEAR IN THE COVERPAGE, YOU MUST USING THE FOLLOWING 
NOTATION IN THE IN FAX NUMBER FIELD;

Name@company@343434

For example;

Support@gfifax@00356340764

The reason for this is that Exchange server does not have access to your personal phonebook, which 
means it can not retrieve the contact name and company to pass to FAXmaker. Therefore you need to 
indicate this information in the fax address itself.

7.    You can attach FAXmaker fax files to your message using the attach file function.

Note; You can not attach any other file except for FAXmaker fax files.

8.    Click on the 'Send' button, when you are ready. The fax will be sent by FAXmaker, and it will notify you
on the status of the fax.



Sending a fax from an e-mail package
To send a fax from an e-mail package, follow the following steps:

I As administrator you could try it out by faxing your registration form as an attachment in the e-mail 
message to GFI FAX & VOICE.

1. Start Exchange.

2. Create a new message in Exchange.

3. Click on the 'To' field to start the Exchange address book.

More:
If you are using Microsoft OUTLOOK



If you are using Microsoft OUTLOOK
FAXmaker support the Outlook address book . This means that you can select a recipient from the 
Outlook address book rather than creating a new FAXmaker address for each recipient.

4.    Click 'New; to create a new address. Select FAXmaker address. A dialog will pop up for a name and a
fax number. Enter GFI FAX & VOICE and the fax number; 00,356-661072.

IIF YOU ARE USING THE PERSONAL ADDRESS BOOK AND YOU WISH TO COMPANY NAME AND 
CONTACT NAME TO APPEAR IN THE COVERPAGE, YOU MUST USING THE FOLLOWING 
NOTATION IN THE IN FAX NUMBER FIELD;

Name@company@343434

For example;

Support@gfifax@00356340764

The reason for this is that Exchange server does not have access to your personal phonebook, which 
means it can not retrieve the contact name and company to pass to FAXmaker. Therefore you need to 
indicate this information in the fax address itself.

5.    You can attach files to your message using the attach file function.

I When attaching files other than FAXmaker fax files, make sure that all fonts and objects that you 
included in your document are also available to the server. Furthermore the document type you use must 
be supported by the fax server machine. Contact your administrator if in doubt. 

6.    When you are ready, click on the 'Send' button. The fax will be sent by FAXmaker, and it will notify you
on the status of the fax.



Specifying additional recipients for the fax
You can specify multiple recipients using your e-mail package, but a list of additional recipients can also 
be added using an extra options line in the body of the message. 

To add an additional recipient, simply type a double colon :: followed by name (optional), company 
(optional) and number, separated by commas at the top of the body of the e-mail message. For example;

::Registration, GFI FAX & VOICE, 00,356661072

You can add a whole series of recipients in this manner.



FAX Options
If    you want to send a particular fax using settings which differ from the default settings set by either your 
administrator or yourself, you can do this by using the Fax options described in this paragraph. If you 
want to change your own Fax default settings, please turn to the next chapter 'Remote Administration'. 

When sending a fax you can enter send options such as high or normal resolution, schedule time, cover 
page to be used etc. The options mentioned below should be typed in at the top of the body of the e-mail  
message, preceded by a double colon <::>. Please note that the recipients of the fax will not be able to 
see these specifications in the received text. 

I You only need to specify fax options in this way, if the defaults which you or your administrator have set,
need to be overridden.

I FAXmaker for Exchange version 5 allows you to install a form which presents the options below 
as 'user friendly' check box options. Ask you administrator for more information if you do not 
have this form.

The following options can be used:

More:
To specify a cover page
To specify high or low resolution
To specify a template
To schedule a fax
To specify a billing code
To attach a file to your fax
Skip Queue
Multiple options



To specify a cover page
::C=cover page name

For example:  ::C=cover1

'Cover page name' stands for the name of your cover page. If you do not want to send a coverpage, but 
by default a coverpage is added, you can override this option temporarily by specifying 'none' instead of a
cover page name. This will cause FAXmaker not to add a coverpage. 

I Remember that the cover page must be stored on the server first, as explained in the chapter 'Remote 
Administration'.



To specify high or low resolution
::'H' or 'N'

For example: ::H

'H' stands for high resolution (200 * 200 dpi) and 'N' for normal resolution (200 * 100 dpi).



To specify a template
::T=template name

For example: ::T=template2

'Template name' stands for the name of the template.

I Remember that the template must be stored on the server first, as explained in the chapter 'Remote 
Administration'.



To schedule a fax
::nn:mm

For example: ::23:15    

'nn' equals hours and 'mm' equals minutes. If you want to send    a fax at a scheduled date or time, this 
option can be used.



To specify a billing code
::Bnnnn 

For example: ::B5

'nnn' can be replaced by any number. This number will be added in the log file and can then be used to 
apportion costs.



To attach a file to your fax
::A=name 

For example: ::A=brochure

'Name' stands for the name of a fax attachment. Multiple attachments can be added to the fax.

I Remember that the fax attachment must be stored previously on the server, as explained in the chapter 
'Remote Administration'. 



Skip Queue
::S 

For example: ::S

'S' stands for skip queue. This option is handy when you have submitted a large fax mailing and you wish 
to send out this fax immediately.



Multiple options
When you are using multiple options in a message, you must type them on the same line, separated by a 
comma.

For example;

:: c=cover1, 23:15, B5 
Send a fax using multiple options

This example sends a fax with 'cover1' as a cover page, scheduled for 23:15 hours, and will be charged 
to billing code 5. 

I Remember that prior to using fax options, you must ensure that you have actually stored the 
attachments, templates and coverpages that you are using.

I FAXmaker is insensitive to case. This means that it does not matter whether you type your text in 
capitals or not. 



Creating a Fax Attachment
Attachments can be useful when certain information is frequently faxed, such as product brochures. As 
these can be graphics intensive, it makes sense to convert them only once to fax format and store them 
as fax attachments on your computer. If you want to store an attachment on your Fax server so that other 
users can also send it out, see the next chapter 'Remote Administration'. 

To create a fax attachment on your own computer:

1.    Start the application in which the document is saved.

a.    From the application menu, choose 'Print Setup'

b.    Select the FAXmaker printer driver and click 'OK'. The e-mail package will pop up.

c. Double-click on the attachment. The viewer will convert and load the fax.

d. To save the fax as an attachment, simply use the 'Save As' function in the viewer.

e. You can either choose to send this attachment immediately, or cancel the send fax process and return 
to the application.

TIP: You can also use the remote administration feature to create an attachment:

1. Print your document to the FAXmaker printer driver

2. Specify FAXadmin as the recipient. (use faxadmin as the fax number)

3. Specify the name of the attachment in the subject field of    the mail message, using the following 
command:

A=Attachment name 

For example: A=brochure

4. Send the message. You will receive a notification that your fax has been stored. The notification will 
include the ready converted fax file!



Receiving a Fax
Incoming faxes are logged in your mailbox. The message will read 'FAX from', followed by the FAX ID 
(CSID). To view the fax, double-click on the message, and then double-click on the attachment. The 
FAXmaker viewer will load and display your fax.
Exchange with a received fax message. The mail message shows the fax report, and the inbox shows the
sender's fax ID



Introduction
FAXmaker has a set of options or defaults which specify how a fax must be sent. These options include 
which coverpage to use, template, fax attachments if any, and even the resolution at which the faxes must
be sent.

The options can be changed by the administrator (from the User Configuration utility on the Fax server, 
see chapter 'User settings'), but also by the users themselves. In this chapter it is explained how a user 
can change his or her defaults. This can be done by sending a message to the faxadministrator. The 
process is called 'Remote administration'.

I If you just want to change the options for sending one particular fax, please turn to the chapter 'Sending 
and Receiving Faxes'. You may also choose not to change the options at all and use the default settings 
your administrator has chosen



FAX admin
Remote administration is done by sending messages to the 'Fax administrator'. The Fax administrator is 
simply a FAXmaker address, which, instead of a number has "faxadmin"    as the fax number. This way 
the FAXmaker server will know that this message concerns an administration option.

It is best to create an entry faxadmin so that the users can send their fax administration messages to this 
recipient.



Coverpage administration options
FAXmaker allows users to add multiple coverpages which can be used interchangeably, and to set a 
particular coverpage as default.

Before a coverpage can be used, the coverpage file (RTF format) must be stored on the server and must 
be given a name.

To store a coverpage:

To: faxadmin

Subject: C=coverpage name {,default }{ ,delete }

Attachment:attach your coverpage

I Do not add multiple attachments. To insert an attachment in your e-mail package, use the 'Attach file' 
command from the message menu.

If you wish this cover page to be the default coverpage, add ', default' in the subject line.

If you wish to delete this coverpage file and name, add ', delete' in the subject line and do not attach a file.



Template administration options
FAXmaker allows users to add multiple templates which can be used interchangeably, and to set a 
particular template as default.

Before a template can be used, the template file (RTF format) must be stored on the server and it must be
given a name.

To store a template:

To: faxadmin

Subject: T=template 
name{ ,default }{ ,delete

Attachment: attach    your template

I Do not add multiple attachments. To insert an attachment in your e-mail package, use the 'Attach file' 
command from the message menu.

If you wish this template to be the default template, add ", default" in the subject line.

If you wish to delete this template file and name, add ", delete" in the subject line and do not attach a file.



Attachment administration options
FAXmaker allows users to store attachments, for example a price list or product brochure. The advantage
of this is that you do not need to resend the physical file each time you want to attach it to your fax.

Before an attachment can be used, the attachment ( in FAXmaker fax format) must be stored on the 
server and it must be given a name.

To store a fax attachment:

To: faxadmin

Subject: A=attachment name{ ,delete }

Attachment:  attach your attachment

Do not add multiple attachments. To insert an attachment in your e-mail package, use the Attach file 
command from the message menu.

If you wish to delete this attachment file and name, add ", delete" in the subject line and do not attach a 
file.



Setting the default fax resolution
Each user can specify the default resolution with which a fax must be sent. A fax can be sent at high 
resolution, which results in a sharper looking fax, but also in longer transmission times. It can also be sent
in normal resolution, which cuts transmission time roughly in half.

To change the default resolution setting:

To: faxadmin

Subject: defaults

In the Message-body:

Resolution = {high} or {normal}



Setting the FAX header
Each user can specify a personal fax header, to be displayed on top of each fax he or she sends. 

To enter a personal fax header:

To: faxadmin

Subject: defaults

In the Message-body:

FAX header = fax    header

Where fax    header is the word or number which will appear on top of the fax.



Setting multiple options at a time
You can specify multiple default settings in one go by adding several command lines. 

For example:

To: faxadmin

Subject: defaults

In the Message-body:

Coverpage = coverpagegfi

Template = templategfi

FAX header = GFI

Resolution = high

This will set coverpagegfi as the default coverpage, templategfi as the default template, GFI as the 
personal fax header and high as the default fax resolution.



Retrieving the defaults
To retrieve all your personal default settings at any one time, simply send a message to faxadmin with 
defaults as the subject of the message.

To retrieve the defaults:

To: faxadmin

Subject: defaults

Leave the Message-body empty

I FAXmaker is insensitive to case. This means that it does not matter whether you type your text in 
capitals or not. 



Introduction
With the FAXmaker Viewer, you can view, print and save fax files. The FAXmaker Viewer can be activated
by double-clicking on the FAXmaker attachment displayed    in the message dialog of the incoming or 
outgoing fax. 



Viewing Faxes
The viewer can be used to:

1.    View incoming or outgoing faxes by double-clicking on the fax attachment in the Message dialog of    
Exchange. The FAXmaker Viewer is automatically activated and will display the fax on your screen.

2. Preview outgoing faxes by double-clicking on the fax attachment in the Message dialog of Exchange. 
The FAXmaker Viewer is automatically activated and will display the fax as it will be sent.

In the Viewer itself you can:

a.    Preview pages one by one, using the 'Next' or 'Previous' command from the 'Page' menu. When your 
document is made up of one page, these functions will be dimmed.

b.    Re-size the document on your screen by choosing either the 'Horizontal Fit' or the 'Vertical Fit' from 
the 'View' menu.

c.    Zoom in or out whilst viewing the document from a number of viewpoints by choosing an appropriate 
zoom value from the 'View' menu. 

d.    Invert the image by choosing the Invert command from the 'View' menu.

e. Flip the image if the fax was received upside down.

f.    Print the document to your local printer by choosing the 'Print' command from the 'File' menu.

g . Save the fax on your hard disk. Choose the 'Save as' function from the 'File' menu (or click on the 
'Save as' icon) and type the file name in the 'Save as' dialog. You can save documents in '*.fax', '*.tiff' or 
'*.dcx' file format. Choose 'Exit' from the 'File' menu.



Scale to Grey
The advanced fax viewer, available for Windows 95 and NT 4, includes a scale to grey option (located in 
the view menu), which allows you to view the fax at a much higher resolution. 



Fax annotation
In Windows 95 or NT 4, you can annotate faxes using the advanced FAXmaker viewer. The following 
annotation tools are at your disposal:

Annotation tools

1. Select 'Annotation'.

2. Draw freehand line.

3. Highlight a particular section of a fax.

4. Draw a straight line.

5. Draw a rectangle.

6. Draw filled rectangle.

7. Add text to a fax.

8. Attach a note.

9. Add text stored in a file.

10. Add a stamp.

To change any of the defaults the tools, right click your mouse above a tool and select properties. The 
default stamp texts can for instance be changed in this way.

I Save your annotations! Your annotations are only made permanent if you select save from the menu.
.The FAXmaker viewer 

Windows NT 4/95 only, other platforms do not    include annotation.



Modem problems
"The modem does not dial out."

In some cases your modem may not dial out, returning the error message "No dial tone". The problem 
could be caused by the fact that not all export modems recognise the dial tone. To solve this, disable 
"Wait for Dial Tone" in the Fax setup window of the server, as explained in the Chapter 'The Fax server'.

"Many faxes fail - can I adjust any settings in FAXmaker to improve this?"

Most of the modem problems are due to modem-command delay-time problems. On-line, this delay is 
very critical for a few modems.

There are two indications that delay might be a problem:

 1. The modem does not respond to a command (error -3102).

 2. The carrier is dropped, i.e. the connection is lost. You can see this from the modem lights: the Carrier 
Detect light will turn off.

You can alter this delay-time that FAXmaker uses, so that you can improve the performance of 
FAXmaker.

I The TIA/EIA class 2 specification states that: "the DCE may fail to recognise a command line if the start 
element of the first character of the command line begins within one millisecond of one half-bit time into 
the stop element of the terminating character of the final result code character issued in response to the 
preceding command line".

I The TIA/EIA class 2.0 specification states that: "the DTE shall not issue a new command line until the 
DCE has finished delivering the complete final result code to the previous command line, including any 
following <cr> and <lf> characters".

There is no mathematical rule to calculate the delay-time. When a modem is offline, FAXmaker uses a 
long delay before it releases a new command (60ms) and in between two characters (20ms). These 
delays are definitely long enough for all modems. The problem is not when the modem is offline. The 
problem is when the modem is on-line. When on-line, the delay has to be long enough so that next 
command will be accepted, but not too long because the modem might drop the carrier because it does 
not receive a command. This behaviour is different amongst the modems on the market. Also, some 
commands require a longer delay than others on the same modem.

There are a lot of differences between modems. The behaviour not only depends on the modem-type, but
also on the EPROM-version of the modem. Because GFI cannot test all different modems/EPROM 
versions, you can change the delay and see if it solves your problem.

More:
Setting delay time
Modem Debug Utility



Setting delay time
First of all before you make any changes it is better to obtain the 'modem debug utility' from GFI. With this
utility, you can easily test different delay times. After obtaining the utility from the GFI website 
(http://www.gfifax.com), you can try the following;

The default pre-command delay (/X) is 20ms, the default delay between two characters (/Y) is 10ms. If 
you use /X and /Y, please try the following combinations:

/X 0    /Y 0

/X 5    /Y 0

/X 20 /Y 5

If you notice a difference using any of these three combinations, most probably your problems will be 
solved.

You can make this change into FAXmaker by adding another line into the <FAXMAKER>\MODEMS.INF 
file. The syntax of a line is 
Name,type,initstring,precommanddelay,interchardelay,voiceformat,voicebitspersample,voicesamplefreq

Let's say you have problems with your class-2 modem 'XYZ' and you got it to work with params /X 20 /Y 
5, then add the following line:

XYZ=class232,AT&F,20,5,0,0,0



Modem Debug Utility
To assist you in debugging modem problems, GFI FAX & VOICE have created a "debug" utility which 
allows you to easily send and receive faxes from the command line/console. This application also creates 
a so called debug file, which you can send to GFI FAX & VOICE via email. This debug file will then 
include valuable information which would allow us to assist you in getting the modem to perform better.

This utility can be found on GFI FAX & VOICE's web site, by going to the support area on 
http://www.gfifax.com (follow the link support).



FAQ on http://www.gfifax.com    
A FAQ is a list of frequently asked questions. GFI FAX & VOICE maintain a support FAQ, which lists 
answers to most common problems. If you have a problem with FAXmaker and have access to the 
INTERNET, please read this FAQ first. 

The FAQ's website URL is http://www.gfifax.com/pages/fnfaq.htm. The 

The web site will always have the most up to date listing of support questions and patches.



How    to request for support
If, after using the FAQ and this manual, you have any problems which you cannot solve yourself, please 
send an e-mail to support@gfifax.com. We will send you a reply as soon as possible.

Be sure however to register your product on the web site first, at http://www.gfifax.com/pages/regfrm.htm.

You can also contact your dealer or distributor or contact one of GFI's offices.




